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WELCOME 
 

Welcome to HughesFlex Cloud PBX! This guide 

is intended to get you up and running with the 

basic features associated with the product. For 

more in-depth information, please see the 

tutorial videos on our website at http://www. 

hughesflex.com. 

This guide covers the three main elements of the 

Hosted PBX product: 

1. CommPortal - A web portal used for 

configuration and calling history 

2. Accession Desktop - A Windows/Mac client for 

calling, instant messaging, and more 

3. Accession Mobile - An app for iOS/Android that 

includes a full-featured dialer, instant 

messaging, and more 

As always, you can also contact our local 

customer care team at 309-277-4111 and we will 

be happy to assist you.  

COMMPORTAL 

 

Commportal is the web portal used to configure 

the features on your new phone system. With 

Commportal you can: 

• View missed calls 

• Listen to voicemail messages 

• Manage your contacts 

• Set up rules to route your calls 

• Perform many other functions 

To get started, go to the login page at: 

https://hughescloud.uccommportal.com. (Consult your 

administrator regarding your default password. 

Once you log in, you will be prompted to create a 

new password.) 

Note: This guide is representative and images 

may vary from your individual CommPortal 

screens. 

Getting Oriented 

Once you are logged in you will see the main 

CommPortal screen with the following menu 

options: 

 

• Dashboard - Quick view of most common 

functions 

• Messages and Calls - Access call history 

• Contacts - Store and retrieve contact 

information 

• Call Manager - Manage how your incoming 

calls are handled 

• Apps - Adds applications to your service 

• Settings - Change your call settings 

  

Dashboard 

CommPortal Dashboard is the main screen for the 

portal. On it you can view a range of information 

including recent calls, messages, contacts, and 

customized settings. 

  

https://hughescloud.uccommportal.com/


 

1. Voicemails - Click this area to view and retrieve 

voicemails 

2. Contacts - Import your contacts from Outlook or 

create new ones, then click on a name to dial 

3. Call Button - Use to make new calls to numbers 

that may not be in your address book 

4. Missed Calls - Click any missed call in the list to 

call the number back 

5. Active Settings - For example, if you are 

forwarding your number, that information would 

appear here; click to adjust 

6. Settings - Logout, refresh or scroll to Help to 

view step-by-step tutorials describing how to 

perform tasks within a user’s CommPortal 

  

 
Messages and Calls 

The Messages and Calls tab displays all recent 

call activity. Here you can retrieve voicemails and 

view calls based on whether they were missed, 

received, dialed, or deleted. 

Click on one of the subtabs to get more detail. 

Click the ‘play’ arrow button to listen to a 

voicemail. Note that you can listen to your 

voicemails in any order. A window (as shown 

over the Messages and Calls screen) will open 

and you will have the option to save or delete 

either on the player screen or main screen. 

Click the ‘New Voicemail’ button at the bottom of 

the page to record and leave a voicemail as a 

memo (your computer must have a microphone 

to use this function). 

Click the (icon) at the end of the line to mark as 

Heard/New, Forward as Email, or Forward as 

Voicemail. 

From the Missed, Dialed, and Received tabs you 

can click on the name and either call them, add 

them to your contacts, or jump to the caller’s 

existing contact information. 

  

Contacts 

The Contacts tab enables you to manage all of 

your contact information. Within it, you can create 

new contacts (using recent call information like a 

missed call or creating a new one from scratch), 

create groups of contacts, or import/export your 

contacts. 

 

 
 

  



The fastest way to add your contacts is to import 

them from your email program. If you use 

Microsoft Outlook, follow these instructions: 

• Open Outlook and go to the File tab, then 

Import and Export 

• A new window should appear 

• Select Export to File and Click Next 

• Select Comma Separated Values from the 

list and click Next 

• Select Contacts from the folder tree and 

click Next 

• Save exported file as ‘Outlook Contacts’ and 

click Next, then save in a place you  

can easily locate such as the Desktop or My 

Documents 

• Go back to the CommPortal Contacts tab 

• Click the Import button 

• Click the Browse button to find the Outlook 

Contacts file 

• Click Import 

• Your contacts are now in CommPortal! 

  

Call Manager 

The Call Manager tab enables you to manage 

how incoming calls are routed to you. The top 

section enables you to change your setting from 

Available to Do Not Disturb, allowing you to route 

calls directly to voicemail if you’re busy. There is 

also a forwarding option that enables 

simultaneous ring with your mobile device. 

 

Settings 

To change your password and/or PIN, click on 

the security options on the Accounts tab. The 

Messaging tab enables you to receive 

notification of a voicemail as an email, manage 

mailbox settings, customize how you are 

notified of a voicemail, configure greetings, and 

more. From Greetings you can personalize your 

voicemail greeting by recording an 

announcement (a microphone is required). 

Use the set keys link (shown below) to configure 

your phone according to your preferences. Once 

you configure your phone, you should not need to 

use this tab frequently. 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

  

  



 

ACCESSION COMMUNICATOR FOR 

DESKTOP 

 

Your HughesFlex phone service can be used to make 

or receive calls from your desk phone, your PC or 

Mac, and your mobile devices.  

For this service to work on your desktop you will 

need to install the Accession Communicator 

software on your PC or Mac. The following 

information helps you to do that.  

Ensure Your Computer is Compatible 

Accession Communicator for Desktop works on 

PCs running Windows 7 or Windows 8. It also 

runs on Macs with OX X 10.7 or later versions. 

You can use your computer’s built-in microphone 

and speakers with Accession Communicator, but 

you will have much better audio quality if you use 

a headset. Accession Communicator works with 

most common headsets, including Bluetooth. It 

will even work with the answer/reject call button 

on some headsets.  

Find Your Password 

You’ll need your company CommPortal phone 

number and password to start using Accession 

Communicator for Desktop. If you don’t have this 

information, contact us at 309-277-4111.  

Download and Install the Software 

First, download Accession Communicator for 

Desktop here:  

https://hughescloud.uccommportal.com.  

You will find it under the Apps tab. 

When prompted, save the file. Then find it in your 

downloads folder and open it to begin the 

installation process.  

Exploring Accession Communicator 

Accession Communicator for Desktop is like 

having your desk phone on your computer. You 

can make and receive calls, hold calls, transfer 

calls, and make three-way calls. 

You can also use it to send instant messages to 

other people in your corporate directory who are 

using Accession Communicator, no matter what 

device they are using. 

Accession should be populated with your 

company contacts. In some cases you may need 

to search for your commonly used contacts by 

typing their name into the ‘enter name or number’ 

field.  

Under the Tools menu, choose Options. Here you 

can see your configuration options for Accession, 

including synchronizing contacts and enabling 

interaction with a desk phone. 

Making Calls 

Making a call is as easy as entering the number 

on the keypad or clicking on a contact’s call 

button. If your contact has more than one 

number, you can choose which one to call from 

the drop-down list. 

If the person you’re calling has caller ID they will 

see your individual business number. 

Receiving Calls 

When someone calls your number, you’ll see a 

pop-up box on your computer screen. You’ll 

also hear a ringing tone through your speakers 

or headset. The pop-up shows the number of 

the person calling you. If that person’s details 

are already in your contacts list, you’ll also see 

the caller’s name. 

Depending on the suite of services you have you 

may see the incoming call on your desk phone, 

on your mobile phone, or on a tablet device. You 

can answer the call on the device that is most 

convenient for you. 

https://hughescloud.uccommportal.com/


 

  

During the Call 

 

While a call is in progress you’ll see the call 

window. Use this window to: 

1. Open a dial pad 

2. Place the call on hold 

3. Transfer the call to another number 

4. Switch on video 

5. Adjust your microphone 

6. Adjust your headset volume 

7. End the call Video Calling 

If the person you’re talking to is also using  

Accession Communicator on the same network, 

you can upgrade your call to video at any time. 

Click on the camera icon to send your video. The 

other person will receive a prompt inviting them 

to switch on video as well. Click on the camera 

icon any time to turn off your video feed.  

Send the Call to Someone Else 

Use the transfer button to send any call to 

another number. A menu will pop up, allowing 

you to choose the number for any contact or to 

type in a completely new number.  

Choosing Which Calls to Receive 

Click on the status selector to reveal ‘More 

Options’ at the end of the menu. This opens the 

Call Manager Status window. Here you can 

choose how calls are treated depending on who 

the call is from. You can also choose your 

preferences for how calls should be handled if 

they are from anonymous numbers, from VIPs, 

or from numbers on your Unwanted Callers list. 

  

Available - Do Not Disturb - Forward 

Calls 

You can tell Accession Communicator how to 

handle your incoming calls. Choose 

between: 

• Online 

• Busy 

• Call Manager 

Busy tells your 

contacts you are 

unavailable, but 

will not block 

them from 

contacting you. 

Call manager 

provides 

features for 

forwarding or do 

not disturb 

settings. 

Note that when 

you change your 

status or set up a 

forwarding 

number, the 

change applies  

on every device on which you use Accession 

Communicator. If you step away from your 

computer and forget to chnge your status, you 

can easily do it from the app on your mobile 

phone (if installed).  



Your Contacts List 

Accession Communicator for Desktop assembles 

a contact list for you to use. Depending on how 

your service is set up, this list may include: 

• Contacts that you type directly into  

Accession Communicator for Desktop 

• Contacts that are contained in the Outlook 

or Mac local address book that is stored 

locally on your computer 

• Contacts that are in CommPortal contacts 

• Contacts that are in your corporate directory 

Use the Options menu to configure how you 

manage your contacts.  

Visual Voicemail 

If you have a voice or video message, the 

indicator will change color and indicate the 

number of messages received.  

Click on the message button to see a list of the 

messages, to view transcriptions of the 

messages into text (where available), to listen to 

the messages, or to forward messages to 

another person.  

Emergency Calls 

Accession Communicator enables you to make 

calls from anywhere on the most convenient 

device. If you place a 911 call from Accession 

Communicator, keep in mind the operator may 

not be able to identify where you are calling from.  

Favorites 

For quick access to frequently-called people, add 

them to your favorites list. Use the righthand 

mouse button to click on any contact and choose 

Add to Favorites from the drop-down list. 

Favorites will appear in both the Favorites and 

Contacts lists.    

More Information 

If you have additional questions about  

Accession Communicator for Desktop call us at  

309-277-4111 or email info@hughestel.com . 

ACCESSION COMMUNICATOR FOR 

MOBILE 

 

Accession Communicator for Mobile is a full 

featured soft phone for your mobile device or 

tablet. It enables you to send and receive calls 

from your business number, as well as instant 

message.  

Ensure Your Device is Compatible 

Accession Communicator for Mobile works on: 

• Android phones and tablets running 3.3.3  

(Gingerbread) or later versions 

• iPhone 3GS, 4, and 4S running iOS 5 or 

later 

• iPads running iOS 5 or later 

Video calling only works on devices that have a 

front-facing camera.  

Find Your Password 

You’ll need your company CommPortal phone 

number and password to start using Accession 

Communicator for Mobile. If you don’t have this 

information, call us at 888-888-8888.  

Download and Install App 

Search for ‘Accession’ in iTunes or the Google 

Play store and download the Accession Mobile 

app to your device. When you open the app you’ll 

be prompted to choose your provider. Scroll to 

‘HughesFlex’ and select. Next you will need to 

enter your username and password. Generally, 

your username will be your 10-digit business 

phone number. If you’ve logged into CommPortal 

before you likely will have changed your 

password. If you don’t know your password 

contact your administrator.  

mailto:info@hughestel.com


Exploring Accession Communicator 

Accession Communicator for Mobile is like having 

your desk phone on your mobile - and a whole lot 

more. You can make and receive calls, hold calls, 

transfer calls, and make three-way calls. You can 

use it to send instant messages to other people 

in your corporate directory who use Accession 

Communicator, no matter what device they’re 

using. You can even push and pull calls over to 

your phone from other twinned devices, mid-call. 

Accession Communicator for Mobile uses 

available Wi-Fi or mobile data services that are 

connected to your mobile phone, so you can 

make and receive calls without using your 

mobile phone minutes.  

Making Calls 

To make a call, enter the number you are calling 

into the Accession dialer, or simply tap on the 

contact and touch the contact’s number. 

Accession Communicator for Mobile will route 

the call over Wi-Fi or using 3G/4G/LTE mobile 

data. If the person you are calling has caller ID 

they will see your individual company phone 

number.  

Receiving Calls 

When someone calls your company number the 

Accession Communicator app will offer you the 

choice to accept or reject the call. 

Depending on the suite of services you have you 

may see the incoming call on your desk phone, 

your desktop, or on a tablet device. You can 

answer the call on whichever device is most 

convenient for you. 

Calls directly to your mobile number utilize the 

device’s native dialer as normal.  

During the Call 

While a call is in progress you will have these 

options:  

• Mute the call 

• Open dial pad 

• Turn on speaker mode 

• Switch 

• End call 

  

When Another Call Comes In 

You may receive a call while you are already on 

a call. Accession Communicator for Mobile 

gives you the choice to: 

• Hold the existing call and answer the new 

call 

• End the existing call and answer the new 

call 

• Ignore the new call 

  

Video Calling 

If the person you’re talking to is also using 

Accession Communicator you can upgrade your 

call to video at any time. Click on the video call 

camera icon to send your video. The other 

person will receive a prompt inviting them to 

switch on video as well. Click on the camera icon 

at any time to turn off your video feed. 

 



Push and Pull call from Another Twinned  
Device 

Call Manager lets you decide who can  

reach you and when. You can tell Accession  

Communicator how to handle your incoming  

calls: 

If Do Not Disturb is selected  

callers will hear a recorded  

voice announcement saying  

that you’re unavailable and  

will be connected to your  

voicemail. None of your  

devices will ring when Do  

Not Disturb is activated. 

You can also tell Accession  

 

Switch: Move an Active Call 

A call on Accession Communicator will be on Wi-

Fi or on a mobile data service. If the connection 

is not reliable the audio may be of poor quality. If 

this happens you can switch the call to a regular 

cell phone connection by pressing the switch 

button. You’ll see the option to switch to ‘This 

device (cellular).’ Remember that the call will 

then start using your mobile minutes. 

You may also choose to switch the call to another 

of your devices running Accession 

Communicator, such as your desktop PC or your 

iPad. To make this switch, choose the option for 

‘Other device,’ then answer the call on whichever 

device is most convenient. 

You may have a call in progress on another 

device that is twinned to the same number, 

such as your desk phone, Accession 

desktop on a PC, or Accession Mobile on a 

tablet device. You can push and pull that 

call to another device running Accession 

Communicator. 

If a call exists that can be pulled, the Accession 

Communicator app on your mobile phone will  

notify you that there is a ‘call available to pull.’ If 

you want to move the call to your mobile phone 

just follow the prompts to pull the call from your 

other device to your mobile phone. This also 

works if you want to pull the call to your tablet 

device. 

  

Choosing Which Calls You Receive 

Swipe or touch the three-line navigation icon from 

the Accession Communicator contacts to reveal 

the other controls needed to access the many 

rich features of Accession Communicator for 

Mobile. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Communicator to Forward All Calls to another 

number. Click this option and you will be 

prompted to enter the number. 

Note that when you change your availability 

status or set up a forwarding number the change 

applies on all devices, including your desk phone. 

Therefore, if you temporarily misplace your 

mobile phone and forget to change your status, 

you can do it from the Accession Communicator 

for Desktop app on your PC, Mac, or iPad.  

 

 



Your Contacts List 

Accession Communicator for Mobile opens 

automatically to your Accession contact list. 

Depending on how your service is set up this list 

may include: 

• Contacts that are contained in the contacts 

list already on your phone 

• Contacts that are in your corporate directory 

• Contacts that are in CommPortal contacts 

Accession Communicator for Mobile provides the 

user with access to corporate directory and 

CommPortal contacts directly on the installed 

device. 

When you are inside the Accession 

Communicator app and looking at the contacts 

page you can press your phone’s menu button or 

action bar to choose which of your contacts are 

presented to you when you are using Accession.  

Visual Voice Mail 

Tap through to the Voicemails tab to see a list of 

messages received, to see transcriptions of the 

messages into text (where available), or to listen 

to the messages.  

 

 

 

Emergency Calls 

If you place a 911 call rom Accession 

Communicator for Mobile it will attempt to make 

the call using the native mobile phone dialer. 911 

calls cannot be made from tablet devices at any 

time.  

Privacy and Protection 

Accession Communicator for Mobile adds a new 

source of contacts that can be displayed, but it 

never changes any existing contacts. 

If you add a contact directly into Accession 

Communicator for Mobile it will open the usual 

contact management feature on your phone. 

Contacts entered directly on your mobile device 

(not in Accession) and existing contacts entered 

directly into the Accession Mobile application are 

uploaded to your contacts on our servers.  

More Information 

If you have additional questions about  

Accession Communicator for Mobile, call us at 

309-277-4111 or email us at info@hughestel.com 

. 
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